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MODULE 1: Overview of the HIV/AIDS Epidemic with an Introduction
to Public Health Surveillance

MODULE OVERVIEW: Presents an introduction to the HIV/AIDS epidemic including the epidemiology of
the disease and public health surveillance measures to combat the disease.

UNIT 1. The Global HIV/AIDS Situation

UNIT OVERVIEW:
This unit focuses on the HIV/AIDS situation globally and in different regions of the world. We consider
recent data from Country Reports, WHO, UNAIDS and other agencies.

LEARNING OBJECTIVES:

By the end of this unit, you should be able to:
= Describe the overall HIV/AIDS situation in the world
= Describe the HIV/AIDS situation in your region.

UNIT CONTENTS:
= Worldwide Epidemic
= HIV Prevalence

UNIT 2. Impact of the HIV/AIDS Epidemic

UNIT OVERVIEW:

In this unit, we will discuss the impact of HIV in terms of mortality, demographics and the economic
situation. We will provide a few examples from other regions to show how profound the impact can be. To
begin this unit, try the questions below.

LEARNING OBJECTIVES:
By the end of this unit you should be able to:
» Describe the impact of HIV/AIDS on individuals and families
= Describe the impact of HIV/AIDS on sustainable development.

UNIT CONTENTS:
» Impact of HIV/AIDS
= Family Impact
= Workforce and Health Services Impact

UNIT 3. Biology, Transmission, Natural History, Prevention and Treatment of HIV Infection and
AIDS

UNIT OVERVIEW:
Extensive research has shown that HIV is the virus that causes AIDS. This unit discusses HIV types and
the prevention and treatment of HIV infection and AIDS.

LEARNING OBJECTIVES:
By the end of this unit you should be able to:
» Explain the basic biology of HIV
Describe HIV transmission routes
Understand the importance of concurrent STls in increasing risk of HIV transmission
Discuss the natural history of HIV and list the major opportunistic infections that occur among AIDS
patients
Describe the major elements of HIV prevention and control programmes
= Recognise that HIV is treated with antiretroviral drugs and that treatment also involves prevention
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and treatment of opportunistic infections.
UNIT CONTENTS:
= Biology of HIV
= HIV Transmission and Natural History
= Preventing Transmission of HIV/AIDS
= HIV/AIDS Treatment

UNIT 4. Overview of Public Health Surveillance

UNIT OVERVIEW:

To achieve HIV prevention and control, AIDS control programmes need information on infection trends
and on demographic and behavioural characteristics of the affected population in a geographic area. This
information is being collected through surveillance systems. This unit discusses the techniques of public
health surveillance.

LEARNING OBJECTIVES:

By the end of this unit you should be able to:
» Describe the components of a surveillance system
» Define sentinel surveillance, laboratory-based surveillance and case definitions
= Define incidence and prevalence.

UNIT CONTENTS:
= Public Health Surveillance
= Past Approaches
= Integrated Disease Surveillance

UNIT 5. Core Elements of HIV Surveillance

UNIT OVERVIEW:
The two core elements of HIV/AIDS surveillance include:
» Reporting of HIV cases and cases of advanced HIV disease requiring treatment
= HIV sero-prevalence surveys in selected clinic populations, such as antenatal clinic attendees and
patients with sexually transmitted infections, and in selected high-risk populations such as injection
drug users and sex workers.
These two elements provide basic information on the distribution of HIV, very basic data on trends in the
epidemic and data that can be used to evaluate prevention programmes.

LEARNING OBJECTIVES:

By the end of this unit you should be able to:
= Discuss the purpose of HIV surveillance
» Describe the core elements of an HIV surveillance system
» Explain the difference between prevalence and incidence
= Discuss the two approaches to HIV surveillance.

UNIT CONTENTS:
= Purpose of HIV Surveillance
= HIV Surveillance Systems
= Approaches to Case Reporting

UNIT 6. Second-Generation HIV Surveillance

UNIT OVERVIEW:

Second-generation HIV surveillance systems are designed to collect and integrate data reported from a
variety of other sources, such as behavioural surveillance, HIV case reporting, death registration and STI
surveillance. Additional data are added to HIV sero-prevalence surveillance and HIV case reporting to
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provide a more complete picture of the HIV/AIDS epidemic. This unit discusses elements of the
secondary-generation surveillance approach.
LEARNING OBJECTIVES:
By the end of this unit you should be able to:
» Describe the concept of second-generation surveillance
» Discuss the various elements of a second-generation HIV surveillance system.

UNIT CONTENTS:
= Second-Generation HIV Surveillance
» Low, Concentrated and Generalised Epidemics

UNIT 7. Ethical Considerations in HIV Surveillance

UNIT OVERVIEW:

Persons with HIV/AIDS and persons and groups at increased risk for HIV/AIDS are vulnerable to a
number of social, legal and physical harms. Because of this, surveillance and special studies need to
address a unique set of ethical issues. This unit discusses those issues and facilitates a more uniform
approach to common ethical issues relating to HIV/AIDS surveillance.

LEARNING OBJECTIVES:
By the end of this unit you should be able to:

= Discuss the ethical principles of respect for persons, beneficence, and justice in the context of HIV
surveillance of high-risk and general populations

= Correctly use the terms related to ethical treatment of participants

= |dentify potential harms caused by HIV and behavioural surveillance

= |dentify potential benefits resulting from HIV and behavioural surveillance

= Describe issues of confidentiality and how they relate to HIV surveillance

= Explain issues of informed consent and institutional review boards and how they relate to HIV
surveillance among high-risk and general populations.

UNIT CONTENTS:
= Addressing Ethical Issues
= Balancing Risks and Benefits
= Confidentiality
= Unlinked Anonymous Testing without Informed Consent
= Informed Consent

UNIT 8. Presenting Data in Charts, Graphs and Tables

UNIT OVERVIEW:

Data derived from public health surveillance systems are analysed to show trends over time and
distribution of cases by demographic and geographic variables. This unit discusses how to display data in
charts and graphs.

LEARNING OBJECTIVES:
By the end of this unit you should be able to:
= List the variables for analysing surveillance data
= |dentify the types of charts and graphs and when the use of each is appropriate.

UNIT CONTENTS:
= Displaying Data
= Graphs
= Charts
= Tables
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UNIT 9. Evaluating a Public Health Surveillance System

UNIT OVERVIEW:
The periodic evaluation of surveillance systems for HIV and sexually transmitted infections is needed in
order to maintain:

= A responsive and relevant system of monitoring shifting disease trends

= Effective disease control and management interventions.

LEARNING OBJECTIVES:
By the end of this unit you should be able to:
= List tasks for evaluating a surveillance system
= Develop a plan for evaluating your own country’s surveillance system.

UNIT CONTENTS:
= Evaluating Surveillance Systems
= Evaluation Process
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MODULE 2: Introduction to HIV Clinical Staging and Case Reporting

MODULE OVERVIEW: Introduces HIV case reporting with an emphasis on WHO guidelines and second
generation HIV and STI surveillance, mortality monitoring, ethical and confidentiality considerations,
analysis and presentation of surveillance data and regional reporting.

UNIT 1. Overview of HIV Case Reporting

UNIT OVERVIEW:
This unit provides an overview of the history, purpose and importance of AIDS and HIV case reporting. It
explains:
= The history of HIV case reporting and how changes in HIV treatments have affected reporting
recommendations and practises
= The natural history of HIV disease and important points in the course of the disease that are
important for surveillance purposes
= The purpose of HIV case reporting
= How other types of HIV programmes can provide data for surveillance purposes.

LEARNING OBJECTIVES:
By the end of this unit, you should be able to:

= Describe the history of HIV and AIDS case reporting and how changes in HIV treatments have
affected surveillance recommendations and practises
Describe the stages in the natural history of HIV disease that can be useful in surveillance
Describe the primary purposes of conducting HIV case reporting
Describe the differences between HIV case reporting and HIV sero-prevalence surveillance (i.e.,
HIV sero-surveillance or HIV sentinel surveillance)
= List four types of HIV-related programmes that can provide data for HIV surveillance.

UNIT CONTENTS:
= The Relationship Between the Natural History of HIV and Surveillance
= Purpose of HIV Case Reporting
= Incorporating Data Collected from HIV Programmes into Case Reporting

UNIT 2. HIV Clinical Staging and Surveillance Case Definitions

UNIT OVERVIEW:
This unit provides an overview of the history and purpose of HIV clinical staging and HIV/AIDS
surveillance case definitions. It includes:
= A brief history of HIV clinical staging systems and surveillance case definitions
A description of the 2006 WHO HIV clinical staging criteria, (the presumptive and definitive criteria)
and the 2006 WHO surveillance case definitions
= Case reporting options and their advantages and disadvantages
= An explanation of the link between HIV clinical staging, ART recommendations, and HIV case
reporting.

LEARNING OBJECTIVES:
By the end of this unit, you should be able to:
= Describe the history of the HIV/AIDS clinical staging system and surveillance case definitions
= Describe the 2006 WHO HIV clinical staging criteria (the presumptive and definitive criteria) and the
surveillance case definition for HIV infection, advanced HIV infection, and AIDS
= List at least one advantage and one disadvantage of HIV case reporting and advanced HIV case
reporting
= Explain the link between HIV clinical staging, antiretroviral treatment recommendations, and
HIV/AIDS case reporting.
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UNIT CONTENTS:

= History of Clinical Staging and HIV/AIDS Case Surveillance Definitions

= The 2006 HIV/AIDS Clinical Staging System and Surveillance Case Definitions

= Linking HIV Clinical Staging, ART Use and HIV Case Reporting

= Annex 2.1. Presumptive and definitive criteria for recognising HIV-related clinical events in adults
(15 years or older) and children (younger than 15 years) with confirmed HIV infection

= Annex 2.2. Presumptive diagnosis of severe HIV disease among HIV sero-positive and HIV-
exposed children

UNIT 3. HIV Case Reporting

UNIT OVERVIEW:

This unit provides an overview of the purpose and importance of HIV case reporting. It explains:
= The purpose of HIV case reporting
= Methods of conducting HIV reporting
= Sources for HIV reporting.

LEARNING OBJECTIVES:
By the end of this section, you should be able to:
= | ist reportable events in HIV case surveillance systems
= Describe the differences between aggregate and case-based HIV reporting
= | ist potential HIV reporting sources
= | ist key variables to include on a HIV case report form
= Describe the purpose of including a patient identifier on HIV case reports.

UNIT CONTENTS:
= Defining Reportable Events for HIV Case Reporting Systems
= Data collection
= Case Reporting Methods
= Case ldentifiers
= Case Report Form
= Monitoring Mortality in HIV Surveillance
= Annex 3.1. HIV case report form for adults and adolescents

UNIT 4. Monitoring Data Quality for HIV Case Reporting Systems

UNIT OVERVIEW:

The periodic evaluation of case reporting systems is needed to maintain a responsive and relevant
system of monitoring disease trends and effective interventions for control and management of disease.
Close monitoring of a newly established case reporting system is needed to identify and fix incorrect
reporting practises. This unit discusses how to monitor the establishment of the HIV case reporting
system and conduct an effective evaluation, with emphasis on evaluating the completeness, timeliness
and validity (or accuracy) of the data collected in the case reporting system.

LEARNING OBJECTIVES:
By the end of this unit you should be able to:
= Describe how to monitor the establishment of the HIV case reporting system
= Describe three elements of a disease under surveillance that a reporting system should monitor
= Describe methods to measure the completeness, timeliness, and accuracy of the reporting system.

UNIT CONTENTS:
= Evaluating Surveillance Systems
= Measuring Completeness of Reporting
= Measuring Timeliness of Reporting
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= Measuring Validity

UNIT 5. Confidentiality and Ethical Issues

UNIT OVERVIEW:

Persons with HIV infection and those at risk are vulnerable to a number of social, legal and physical
harms. All programmes in HIV case reporting must address these unique ethical issues. This unit
discusses those issues and guides you in methods to keep patients’ information confidential.

LEARNING OBJECTIVES:

By the end of this unit, you should be able to:
= |dentify potential harms caused by the release of information regarding persons with HIV
= Describe issues of confidentiality and how they relate to HIV case reporting.

UNIT CONTENTS:
= Addressing Ethical Issues
= Confidentiality and Security Considerations

UNIT 6. Analysis, Interpretation and Dissemination of HIV Case Reporting Data

UNIT OVERVIEW:

This unit describes how HIV reporting data can be analysed, summarised, interpreted and disseminated. It
different analyses that can be performed from HIV case reporting data and the types of reports that should
and disseminated. It also outlines the elements of an HIV annual case reporting report.

LEARNING OBJECTIVES:
By the end of this unit, you should be able to:
= Summarise data obtained from HIV case reporting activities
= Interpret HIV case reporting data
= Describe the basic elements of an annual HIV case reporting report.

UNIT CONTENTS:
= Analysing HIV Case Reporting Data
= Displaying and Interpreting Surveillance Data
= Presenting HIV Case Reporting Data
= Formats for Disseminating Results from HIV Case Reporting
= HIV Case Reporting and Annual Report
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UNIT 7. Operational Aspects of the HIV Case Reporting System

UNIT OVERVIEW:
This unit provides guidelines for developing an HIV case reporting operational manual and for preparing
an action plan to implement an HIV case reporting system in a country.

LEARNING OBJECTIVES:
At the end of this unit, you will be able to:
» Design an operational manual for HIV case reporting in your country
= Develop an action plan for implementing an HIV case reporting system in your country.

To begin operationalising the HIV case reporting system in your country, you will need to:
= Develop a country-specific operational manual for HIV case reporting (or modify an existing
operational manual used in AIDS case reporting)
» Develop country-specific implementation work plans
= QOutline the steps necessary for implementing case reporting in your country and how this fits within
guidelines and operations for regional case reporting.

UNIT CONTENTS:
= Operational Manual
= National Action Plan Worksheet
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MODULE 3: HIV Sero-Prevalence Surveillance

UNIT 1. Objectives and Approaches to HIV Surveillance

UNIT OVERVIEW:
This unit gives an overview of HIV surveillance, including objectives and approaches. The unit provides
the rationale for recommending HIV sentinel surveillance a core activity of HIV surveillance for Asia.

LEARNING OBJECTIVES:
By the end of this unit, you should be able to
= define the terms HIV surveillance, second-generation HIV surveillance, HIV sero-surveillance, and
HIV sentinel surveillance as used in this module
= describe how certain epidemiologic principles and also the stage of the epidemic in a location guide
HIV sero-surveillance
= compare AIDS case surveillance and HIV sero-surveillance, identify the strengths and weaknesses
of each, and describe how the two are complimentary
= identify the main objectives of HIV sero-surveillance
= describe the three main approaches to conducting HIV sero-surveillance
= describe HIV incidence surveillance
= identify alternative sources of HIV testing data that can be used for HIV surveillance in a second-
generation surveillance system

UNIT CONTENTS:
= Definitions and Terms
= Overview of HIV Sero-surveillance
= Annex 1.1, Steps for Setting Up an HIV Sentinel Surveillance System

UNIT 2. Selection of Sentinel Populations and Sentinel Sites

UNIT OVERVIEW;
This unit will describe selection of populations and sites for inclusion in HIV sentinel surveillance based on
the local epidemiology and the ability to access populations at risk.

LEARNING OBJECTIVES:
By the end of this unit you should be able to
= identify appropriate sentinel populations according to the local epidemiological situation
= identify potential venues that provide access to sentinel populations
= list the criteria for selection of sentinel sites
= identify sites in your district that fit the selection criteria.

UNIT CONTENTS:
= Selecting Sentinel Populations
= Access to Sentinel Populations
= Criteria for Site Selection
= Recommendations

10
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UNIT 3. Sample Size, Sampling Methods, Duration and Frequency of Sampling

UNIT OVERVIEW:

This unit describes the process of sampling, including sample size estimation and the frequency, duration
and methods of sampling. The unit provides the rationale for using a consecutive sampling for HIV
sentinel surveillance.

LEARNING OBJECTIVES:
By the end of this unit you should be able to
» explain the process of sampling in the context of sentinel surveillance
» determine eligibility criteria for inclusion in the sample
= choose an appropriate sampling scheme
= plan the duration and frequency of sampling required for sentinel surveillance in your sites.

UNIT CONTENTS:
= Components of Sampling
= Sampling Schemes

UNIT 4. Specimen and Data Collection

UNIT OVERVIEW:
This unit provides the rationale for conducting HIV tests using unlinked anonymous blood specimens. It
also describes the process of data collection, including proper procedures for forms and data entry.

LEARNING OBJECTIVES:
By the end of this unit you should be able to
» understand the rationale for conducting unlinked anonymous testing for HIV sentinel surveillance
= explain methods for keeping samples anonymous and unlinked
= explain the importance of standardised forms for data collection
= describe the protocols for data collection
= identify the necessary demographic information to be collected for analysis

UNIT CONTENTS:
= Approaches to HIV Testing
» Procedures for Unlinked Anonymous Testing without Consent
» Annex 4.1, Unlinked Anonymous HIV Surveillance Data Collection Form
= Annex 4.2, Operational Procedures for Unlinked Anonymous HIV Sentinel Surveillance Supported
by the CDC Global AIDS Program

UNIT 5. Choosing an HIV Test

UNIT OVERVIEW:
This unit describes different options for HIV testing and provides the rationale for each.

LEARNING OBJECTIVES:
By the end of this unit you should be able to
» describe the advantages and disadvantages of different HIV testing options
= describe how to choose a strategy for HIV testing
= understand the difference between sensitivity and specificity of a laboratory test
= identify the phases of the testing process, and what quality control and quality assurance
programmes should be implemented in each phase

11
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UNIT CONTENTS:
= Selecting an HIV Antibody Test
= Selecting an HIV Testing Algorithm
= Selection of HIV Testing Algorithms for Surveillance
= Ensuring Quality in the Laboratory

UNIT 6. Training and Supervision

UNIT OVERIVEW:
This unit outlines the responsibilities, training and supervision of personnel involved in HIV sentinel
surveillance.

LEARNING OBJECTIVES:

By the end of this unit you should be able to
= describe requirements for staffing, training and supervising of HIV sentinel surveillance programmes
= identify potential sources of conflict when adding supervisory staff to existing programmes

UNIT CONTENTS:
= Training
= Supervision
= Annex 6.1, Outline of a Survey Protocol

UNIT 7. Data Management, Analysis and Interpretation

UNIT OVERVIEW:
This unit describes the process of data collection, including proper procedures for forms and data entry. It
also explains the over-all idea of data analysis and interpretation.

LEARNING OBJECTIVES:
By the end of this unit you should be able to
» describe the process for sero-survey data entry
= list the variables for analysing sentinel surveillance data

UNIT CONTENTS:
= Data Entry and Management

UNIT 8. Uses and Dissemination of HIV Sentinel Surveillance Data

UNIT OVERVIEW:
This unit describes the uses of HIV sentinel surveillance data for public health action, and how to
disseminate them most effectively.

LEARNING OBJECTIVES:

By the end of this unit you should be able to
= discuss various uses for HIV sentinel surveillance data
= discuss how to develop a clear and understandable message about surveillance data
» understand the tools for disseminating data to target groups

UNIT CONTENTS:
= Uses of HIV Surveillance Data
» Disseminating HIV Surveillance Data

12
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MODULE 4: Sexually Transmitted Infection Surveillance

MODULE OVERVIEW: Describes the interaction between HIV infection and sexually transmitted
infections (STIs). The module describes how to develop and operate systems for STl surveillance in the
context of Integrated Disease Surveillance (IDS).

UNIT 1. Introduction to STI Surveillance and the Relationship between STls and HIV

UNIT OVERVIEW:

This unit describes the general state of sexually transmitted infections (STIs) and STI surveillance in
resource-constrained countries around the world. It also discusses the behavioural, epidemiological and
immunological links between STIs and HIV infection.

LEARNING OBJECTIVES:
By the end of this unit, you should be able to:
= Describe the three main areas of inter-relationship between STls and HIV
= Describe the basic principles of the Integrated Disease Surveillance system
= Explain how an STl increases susceptibility to HIV
= Explain how an STl increases the risk of transmitting HIV
» Describe how STI surveillance data can be used in understanding HIV epidemics.

UNIT CONTENTS:
= STI Surveillance
» STl and HIV Inter-relationship

UNIT 2. STI Surveillance Methods, Concepts and Terms

UNIT OVERVIEW:

The components of sexually transmitted infection (STI) surveillance work together to provide a more
complete picture of the STI situation. This unit describes these components and how the data from
surveillance can be used. Also explained are the terms and concepts of ST surveillance.

LEARNING OBJECTIVES:
By the end of this unit you should be able to
= Discuss the components of an STI surveillance system
= Discuss the uses of STI surveillance data
= Describe the difference between aetiologic and syndromic STI diagnosis and surveillance
» Determine the difference between basic and advanced STI surveillance activities and how these
activities should be used, depending on the type of HIV epidemic
= Describe IDS case reporting.

UNIT CONTENTS:
= Components and Uses of STI Surveillance Systems
= Aetiologic versus Syndromic Case Reporting
» Basic and Advanced STI Surveillance
= Annex 2.1, Health facility Outpatient and Inpatient IDS Case Reporting Form

UNIT 3. Universal Case Reporting and Sentinel Surveillance for STls

UNIT OVERVIEW:
This unit compares and contrasts universal sexually transmitted infection (STI) case reporting and STI
sentinel surveillance.

14
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LEARNING OBJECTIVES:
By the end of this unit on STI universal case reporting and sentinel surveillance, you should be able to:
= Discuss the purpose of each of these systems of surveillance
= Discuss the advantages and disadvantages of each
» Define when each should be implemented
= Define the population studied for each
» Discuss reporting under Integrated Disease Surveillance (IDS).

UNIT CONTENTS:
» Universal STI Case Reporting
= STI Sentinel Surveillance
= Combined Universal and Sentinel Surveillance Case Reporting

UNIT 4. Reporting, Data Management and Analysis

UNIT OVERVIEW:
This unit discusses sexually transmitted infection (STI) case reporting and the information flow from
health facilities to district to national level. It also reviews how to handle and analyse data.

LEARNING OBJECTIVES:
By the end of this unit you should be able to:
= Describe how to plan your data collection and ensure confidentiality
= describe the flow of data from health facilities to district to national level
= Discuss the roles and responsibilities of each person involved in data handling at each level
= Discuss the analysis of STl data
= Explain how to use the Integrated Disease Surveillance (IDS) strategy to plan STI data collection
and reporting.

UNIT CONTENTS:
= Planning Your Data Collection
= Collecting Data
= Entering and Analysing Data
= Annex 4.1, District IDS Summary of Outpatient and Inpatient Surveillance Reports

UNIT 5. Specialised Techniques: Prevalence Assessment and Combined STI/HIV Behavioural
Surveillance Surveys

UNIT OVERVIEW:

This unit describes four types of specialised surveys and defines when and how to use each:
= STl prevalence assessment and monitoring
» Combined behavioural and STI/HIV surveys.

LEARNING OBJECTIVES:
By the end of this unit you should be able to:
» Discuss the use of prevalence assessment in a comprehensive STl surveillance system
= Discuss how STI sero-prevalence studies can be linked to HIV sero-prevalence studies
= Discuss the assessment of STls in serological surveys
= Discuss how prevalence assessment studies can be linked to behavioural surveillance surveys
= |dentify the STls most suitable for inclusion in combined STI/HIV behavioural surveillance studies.

UNIT CONTENTS:
= Prevalence Assessment and Monitoring
= Combined STI/HIV Prevalence and Behavioural Surveillance Surveys
= Reporting Results of Special Studies

15
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UNIT 6. Specialised Techniques: Monitoring of Anti-Microbial Resistance and Assessment of STI
Syndrome Aetiologies

UNIT OVERVIEW:

This unit describes two types of specialised surveys and defines when and how to use each:
= Anti-microbial resistance monitoring
= Assessment of sexually transmitted infection (STI) syndrome aetiologies.

LEARNING OBJECTIVES:
By the end of this unit you should be able to:
= Discuss the objectives of anti-microbial resistance monitoring in Neisseria gonorrhoeae and
Haemophilus ducreyi
» Discuss why assessment of syndrome aetiologies is a core component of a comprehensive STI
surveillance system
» Describe the two main STI syndromes and their microbiological causes
» Discuss how data from assessments of syndrome aetiologies are used to revise syndromic
treatment guidelines.

UNIT CONTENTS:
= Monitoring of Anti-microbial Resistance of STI Pathogens
» Assessing STI Syndrome Aetiologies

17
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MODULE 5: Surveillance of HIV Risk Behaviours

UNIT 1. Behavioural Surveillance

UNIT OVERVIEW:
In this unit, you will learn basic information about behavioural surveillance, including its purpose and
history and important things to consider.

LEARNING OBJECTIVES:
By the end of this unit, you should be able to:
= define surveillance
= summarise the uses of behavioural surveillance
= summarise issues to consider when designing a surveillance system
= summarise what steps to take for a sustainable surveillance system.

UNIT CONTENTS:
= Designing a Behavioural Surveillance System
= Steps for Conducting Behavioural Surveillance

UNIT 2. Measures and Indicators for Behavioural Surveillance

UNIT OVERVIEW:
In this unit, you will learn about selecting appropriate measures and indicators for behavioural
surveillance.

LEARNING OBJECTIVES:
By the end of this unit, you should be able to:
= understand the characteristics of a good indicator
= select indicators for behavioural surveillance
= understand the main problems with indicators
= discuss surveillance comparing standardised indicators and locally adapted indicators.

UNIT CONTENTS:
= Selecting Indicators For Behavioural Surveillance
= Standardised Versus Locally Adapted Indicators

UNIT 3. Formative Assessment

UNIT OVERVIEW:

In this unit, you will learn about the theoretical and practical knowledge needed to plan behavioural
surveillance activities. You will learn what information should be collected during the pre-surveillance
activities and what methods you can use. This is called formative assessment.

LEARNING OBJECTIVES:
By the end of this unit, you should be able to:
= identify and understand the purpose of formative assessment
= describe and select the methods used in formative assessment.

19
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UNIT CONTENTS:
= Formative Assessment Methods
= Qualitative Data Collection Methods
= Rapid Assessment Tools
= Special Ethical Considerations for Conducting Formative Assessment

UNIT 4. Survey Methods

UNIT OVERVIEW:
In this unit, you will learn about selecting and adapting instruments and methods for behavioural
surveillance.

LEARNING OBJECTIVES:
By the end of this unit, you should be able to:
= select appropriate data collection methods
= design and adapt survey instruments
= understand measurement error and how to reduce it
= think about potential difficulties in your fieldwork and find solutions
= select appropriate interviewers and supervisors.

UNIT CONTENTS:
= Data Collection Methods
= Survey Instruments
= Measurement Error
= Fieldwork Practicalities
= Selecting Appropriate Interviewers and Supervisors

UNIT 5. Sampling

UNIT OVERVIEW:

In this unit, you will learn key terms and approached to sampling. This will allow you to discuss and select

sampling options for behavioural surveillance activities.

LEARNING OBJECTIVES:
By the end of this unit, you should be able to:
= explain how sampling a population is different from a complete count
= outline the purpose of sampling
= explain the most important concepts in sampling
= explain the need for sampling designs that are more complex
= describe sampling issues and options for behavioural surveillance
= describe how to choose a sampling approach.

UNIT CONTENTS:
= Concepts, Terms and Definitions
= Selecting a Sample
= Calculating Sample Size
» Additional Issues in Calculating Sample Size
» Probability Sampling Techniques
» Sampling of Most-at-Risk Populations
» Sampling Options in the Absence of a Sampling Frame
» New Sampling Techniques
= Determining Sampling Approach
= Annex 5-1: Summary of Probability Sampling Techniques
» Annex 5-2: Formula for Sample Size Calculation

20
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= Annex 5-3: Random Number Table

21
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UNIT 6. Data Analysis and Use

UNIT OVERVIEW:
In this unit, you will learn the skills required to ensure behavioural surveillance data are analysed,
disseminated and used appropriately.

LEARNING OBJECTIVES:
By the end of this unit, you should be able to:
= discuss data management issues
= describe the types of data analysis commonly used in behavioural surveillance
= understand the steps for appropriate data analysis and use
= list the different audiences for the data from behavioural surveillance
= interpret and package data appropriately for the different audiences.

UNIT CONTENTS:
= Data Management Issues and Activities
= Data Analysis
= Using Behavioural Surveillance Data

UNIT 7. Ethical Considerations

UNIT OVERVIEW:
In this unit, you will learn about ethical matters and requirements in behavioural surveillance.

LEARNING OBJECTIVES:

By the end of this unit, you should be able to:
= explain the basic ethical principles of working with human subjects
= define informed consent and the procedures that are used
= understand the importance of confidentiality and how to ensure it
= discuss ethical considerations unique to behavioural surveillance.

UNIT CONTENTS:
= Ethical Principles of Conducting Human Subjects Research
*» Informed Consent
= Confidentiality
= Ethical Considerations Unique to Behavioural Surveillance
= Annex 7-1: Samples of Verbal Consent Forms for Participation in HIV Biological and Behavioural
Surveys
= Annex 7-2: Declaration of Helsinki on Ethical Principles for Medical Research

22




HIV/AIDS Surveillance Training Module Curriculum: Module Outlines

23



HIV/AIDS Surveillance Training Module Curriculum: Module Outlines

MODULE 6: Surveillance of Most-at-Risk Populations (MARPS)

MODULE OVERVIEW: This module introduces HIV surveillance among high-risk populations. Eight high-
risk populations are described in-depth. Specific surveillance techniques are recommended. Detailed
case studies are provided for each population to help participants think through implementation.

UNIT 1. Introduction to Surveillance of Most-At-Risk Populations

UNIT OVERVIEW:

Unit 1 introduces HIV surveillance in most-at-risk populations. This unit discusses the special ethical
considerations of conducting behavioural and sero-surveillance in high-risk groups, as well the sampling
approaches best suited for high-risk populations.

LEARNING OBJECTIVES:
By the end of this unit, you should be able to:
= discuss the importance of surveillance in most-at-risk populations (MARPS) in different epidemic
settings
= identify MARPs in your region
= discuss the advantages and disadvantages of different sampling approaches, especially in the
context of surveillance among MARPs
» understand the special ethical issues of surveillance among MARPs.

UNIT CONTENTS:
= Sampling Methods
= Measures and Indicators
» Ethical Considerations
» Annex 1.1: Formula for Sample Size Calculation
» Annex 1.2: Estimating the Size of Your Target Population
= Annex 1.3: Choosing an HIV Test
» Annex 1.4: Examples of Verbal and Written Consent to Participate in a Survey

UNIT 2. Sex Workers

UNIT OVERVIEW:

This unit describes the background and special considerations for conducting behavioural surveillance
and HIV sero-surveillance among sex workers (SWs). The unit ends with an extensive case study
concerning SWs and specific study issues.

LEARNING OBJECTIVES:
By the end of this unit, you should be able to:
= understand the diversity of sex work
= understand the role of sex workers in the HIV epidemic
= describe options for sampling sex workers
= describe the special ethical considerations associated with conducting HIV surveillance activities
among sex workers.

UNIT CONTENTS:
» Conducting a Formative Assessment
= Selecting a Sampling Method
= Measures and Indicators
» Special Ethical Considerations
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UNIT 3. Injecting Drug Users

UNIT OVERVIEW:

This unit describes the background and special considerations associated with conducting HIV
behavioural and sero-surveillance among injecting drug users (IDUs). The unit includes a case study
highlighting special issues in conducting surveillance among IDUs.

LEARNING OBJECTIVES:
By the end of this case study, you should be able to:
= describe special considerations associated with doing HIV surveillance among IDUs
= describe options for sampling and surveillance methods among IDUs
= list key biological and behavioural measures used for tracking the HIV epidemic among IDUs
= describe the special ethical considerations associated with conducting HIV surveillance activities
among IDUs.

UNIT CONTENTS:
= Conducting a Formative Assessment
= Selecting a Sampling Method
= Measures and Indicators
= Special Ethical Considerations

UNIT 4. Men Who Have Sex with Men

UNIT OVERVIEW:

This unit describes the background and special considerations associated with studying men who have
sex with men (MSM). It explains sampling and surveillance methods and recommends specific
surveillance methods for this group. The unit ends with a case study about MSM and specific study
issues.

LEARNING OBJECTIVES:
By the end of this unit, you should be able to:
= describe the special considerations associated with surveillance in men who have sex with men
(MSM)
= list organisations that possibly can assist in surveillance of MSM
= describe options for sampling and surveillance methods among MSM.

UNIT CONTENTS:
= Conducting a Formative Assessment
= Selecting a Sampling Method
= Measures and Indicators
= Special Ethical Considerations

UNIT 5. Mobile Populations

UNIT OVERVIEW:

This unit describes the background and special considerations associated with conducting HIV/STI and
behavioural surveillance among mobile populations. It explains sampling and surveillance methods and
recommends specific surveillance methods for this group.

LEARNING OBJECTIVES:
By the end of this unit, you should be able to:
= distinguish between the various types of mobile populations
» describe options for sampling and surveillance methods among mobile populations
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= describe the special considerations associated with surveillance in mobile populations.
UNIT CONTENTS:

= Conducting a Formative Assessment

= Selecting a Sampling Method

= Measures and Indicators

= Special Ethical Considerations

UNIT 6. Street Children

UNIT OVERVIEW:
This unit describes the background and special considerations for conducting behavioural and biological
HIV surveillance among street children.

LEARNING OBJECTIVES:
By the end of this unit, you should be able to:
= understand the role of street children in the HIV epidemic
= describe options for sampling of street children for surveillance
= describe the special ethical considerations associated with conducting HIV surveillance activities
among street children.

UNIT CONTENTS:
= Conducting a Formative Assessment
= Selecting a Sampling Method
= Measures and Indicators
= Special Ethical Considerations

UNIT 7. Prisoners

UNIT OVERVIEW:

This unit describes the background and special ethical considerations associated with conducting HIV
surveillance in populations of prisoners. It presents sampling options and recommends specific
surveillance methods for this group.

LEARNING OBJECTIVES:
By the end of this unit, you should be able to:
= understand the factors that contribute to the high prevalence of HIV among prisoners
= describe options for sampling and surveillance methods within prison populations
= describe the special ethical and legal considerations associated with surveillance in prisoner
populations.

UNIT CONTENTS:
= Conducting a Formative Assessment
= Selecting a Sampling Method
= Measures and Indicators
= Special Ethical Considerations

UNIT 8. Uniformed Personnel

UNIT OVERVIEW:

This unit describes the background and special considerations associated with conducting behavioural
and HIV sero-surveillance among uniformed personnel, such as police and members of the military. It
explains sampling and surveillance methods and recommends specific surveillance methods for this

group.
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LEARNING OBJECTIVES:

By the end of this unit, you should be able to:
= describe the special considerations associated with surveillance of uniformed personnel
= describe options for sampling and surveillance methods among uniformed personnel.

UNIT CONTENTS:
= Conducting a Formative Assessment
= Selecting a Sampling Method
= Measures and Indicators
= Special Ethical Considerations

UNIT 9. Out-of-School Youth

UNIT OVERVIEW:
This unit describes the background and special considerations for conducting behavioural and biological
HIV surveillance among out-of-school youth.

LEARNING OBJECTIVES:
By the end of this unit, you should be able to:
= understand the diversity of out-of-school youth
= understand the role of out-of-school youth in the HIV epidemic
= describe options for sampling out-of-school youth for surveillance
= describe the special ethical considerations associated with conducting HIV surveillance activities
among out-of-school youth.

UNIT CONTENTS:
= Conducting a Formative Assessment
= Selecting a Sampling Method
= Measures and Indicators
= Special Ethical Considerations
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MODULE: Producing a National HIV Sentinel
Surveillance and Estimates Report

MODULE OVERVIEW: This module focuses on writing and presentation of country or region surveillance
information. This training module is meant primarily for staff who will assist surveillance officers to develop
an annual surveillance report then deliver the information to a variety of audiences.

UNIT 1. Overview of a National Sentinel Surveillance and Estimates Report

UNIT OVERVIEW:

This unit presents the objectives for publishing a national sentinel surveillance and estimates report. It
explains the primary audiences of the report and the structure and components of a good surveillance
report. It also discusses planning activities, including identifying data sources, developing an outline for
the report, and developing a timeline for completion.

LEARNING OBJECTIVES:
By the end of this unit you will be able to:
= understand the uses of a national sentinel surveillance and estimates report
= identify the target audiences for a national sentinel surveillance and estimates report
= list the components of a good surveillance report
» develop an outline of the report with assignments and a timeline with due dates.

UNIT CONTENTS:
= Who will Read the Report
» Components of a Good Report
» Planning the Report
» Annex 1.1. Sample Outline of a Surveillance Report

UNIT 2. Writing the Results and Methods Sections

UNIT OVERVIEW:

This unit demonstrates how to write the results and methods sections of a national sentinel surveillance
and estimates report. It describes how to present data in the form of tables and data graphics. It also
discusses how to write text to describe and highlight key results. This unit shows participants how to write
the methods section using the standard protocols or operation manuals of surveys and research studies.

LEARNING OBJECTIVES:
By the end of this unit you will be able to:
= use tables, graphs, charts and maps to describe data effectively
= use written text to summarise and highlight key results
= describe the procedures and analytical methods used to produce data for the report.

UNIT CONTENTS:
= Preparing the Results Section
= Preparing the Methods Section
= Annex 2.1. Guide to Selecting Data Graphics

UNIT 3. Summarising, Interpreting, and Making Final Conclusions for National Surveillance Data

UNIT OVERVIEW:

This unit describes how to write the sections of the report that are essential to summarising, interpreting,
and making conclusions using surveillance data. The unit also discusses how to select a title and make
revisions.

28




HIV/AIDS Surveillance Training Module Curriculum: Module Outlines

LEARNING OBJECTIVES:
By the end of this unit you will be able to:
= write a discussion interpreting results of the surveillance report
= pose conclusions accompanied by recommendations
= understand how sentinel surveillance data can be used to generate estimates and projections
= write an introduction containing relevant background and objectives
= prepare references that are cited throughout the report
= write the executive summary
= acknowledge contributors to the report
= develop an appropriate title for the report
= revise drafts of the report.

UNIT CONTENTS:
= Preparing the Discussion Section
= Generating HIV/AIDS Estimates and Projections Using EPP and SPECTRUM
= Writing Conclusions and Recommendations Section
= Preparing the Introduction Section
= Preparing the References
= Writing the Executive Summary
= Acknowledgments
= Title Page and Publication Details
= Revising the Draft Report
= Annex 3.1. When Using EPP and SPECTRUM
» Annex 3.2. Sample of Executive Summary

UNIT 4. Tying it All Together and Finalising the Report

UNIT OVERVIEW:

This unit discusses how to write the sections of the report which are the tools to help the audience read
the report. These sections include the list of acronyms and abbreviations, the list of figures and tables, the
table of contents, and the appendix. This unit also addresses final editing of the report and publication
and distribution methods.

LEARNING OBJECTIVES:
By the end of this unit you will be able to:
= create a list of acronyms and abbreviations
= create a list of figures and tables
= create a table of contents
= prepare an appendix with data tables
= decide how to design a report cover
= edit the report
= be familiar with publishing formats available.

UNIT CONTENTS:
= Acronyms and Abbreviations
= List of Figures and Tables
= Table of Contents
= Creating an Appendix
= Report Cover
= Report Editing
= Report Publication and Distribution
= Annex 4.1. Surveillance Report Checklist
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UNIT 5. Disseminating Surveillance Data in other Formats

UNIT OVERVIEW:

There are various strategies to disseminate the information and data amassed in your surveillance report.
This unit introduces two communication formats (fact sheets and press releases) that may be used to
disseminate surveillance data in addition to the national surveillance report.

LEARNING OBJECTIVES:

By the end of this unit, you should be able to:
= write and distribute a fact sheet highlighting disease surveillance data
= assemble a list of media contacts
= write and distribute a press release.

UNIT CONTENTS:
= Writing a Fact Sheet
= Writing a Press Release
= Annex 5.1. Fact Sheet Example from UNAIDS
= Annex 5.2. Fact Sheet Template One: Topical Format
» Annex 5.3. Fact Sheet Template Two: FAQ Format
» Annex 5.4. Press Release Template One
» Annex 5.5. Press Release Template Two
» Annex 5.6. Press Release Template Three
» Annex 5.7. Example of a Poorly Written Press Release
» Annex 5.8. Contact List Template
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MODULE: HIV-1 BED Incidence EIA Surveillance

UNIT 1. Introduction and background: why HIV-1 incidence surveillance?

UNIT OVERVIEW:

This unit gives the global picture of HIV-1 incidence, the rationale for conducting HIV-1 incidence
surveillance, and places HIV-1 incidence surveillance within the context of Second Generation HIV-1
Surveillance.

LEARNING OBJECTIVES:
By the end of this unit, you should be able to
= Define HIV-1 incidence and HIV-1 prevalence
= Describe HIV-1 subtype diversity
= Differentiate between HIV-1 incidence and prevalence surveillance
= Summarize the importance of HIV-1 incidence surveillance

UNIT CONTENTS:
= Global picture of HIV incidence
HIV transmission patterns
HIV-1 incidence vs. HIV-1 prevalence: the need for HIV-1 incidence surveillance
Using HIV-1 surveillance data for estimating HIV-1 incidence
HIV-1 incidence surveillance within the context of Second Generation HIV-1 Surveillance

UNIT 2. Overview of methods to estimate HIV-1 Incidence

UNIT OVERVIEW:

This unit reviews methods that are currently available to measure HIV-1 incidence with a discussion of the
strengths and limitations of each. The unit illustrates how the HIV-1 BED incidence EIA addresses many,
but not all, of these limitations.

LEARNING OBJECTIVES:
By the end of this unit, you should be able to
= Describe several epidemiological study designs to measure HIV-1 incidence
= Describe several laboratory methods to measure HIV-1 incidence
= List strengths and limitations of the various methods to measure HIV-1 incidence

UNIT CONTENTS:
= Epidemiological methods to measure HIV-1 incidence
= L aboratory-based methods to measure HIV-1 incidence

UNIT 3. Overview of the HIV-1 BED incidence EIA

UNIT OVERVIEW:
This unit presents an overview of the HIV-1 BED incidence assay including the steps for using the assay,
how the assay works, and how the 155 day window period was determined.
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LEARNING OBJECTIVES:
By the end of this unit, you should be able to:
= Describe how the HIV-1 BED incidence EIA works.
= Understand the relationship between optical density (OD) and window period duration.

UNIT CONTENTS:
= The ideal assay for recent infection detection
= How the HIV-1 BED incidence EIA works
= The HIV-1 BED incidence EIA testing algorithm
= Determination of optimal cut off and calibration of the window period
= Classification of specimens
= Putting it all together: testing specimens at different time points

UNIT 4. Epidemiological considerations, study designs, and ethical issues for HIV-1 incidence
surveillance

UNIT OVERVIEW:

This unit presents the epidemiological principles that underlie cross-sectional HIV-1 incidence measures
and the study design options that are suitable for applying the HIV-1 BED incidence EIA for surveillance.
The unit also discusses ethical issues when applying of the HIV-1 BED incidence EIA to surveillance.

LEARNING OBJECTIVES:
By the end of this unit, you should be able to
= Describe the ideal study design for the HIV-1 BED incidence EIA
= Integrate the HIV-1 BED incidence EIA into HIV-1 sentinel surveillance
= Integrate the HIV-1 BED incidence EIA into general population-based cross-sectional surveys
= List the ethical criteria for conducting the HIV-1 BED incidence EIA in unlinked anonymous testing
sentinel surveys and population-based surveys

UNIT CONTENTS:
= Integration of the HIV-1 BED incidence EIA into existing HIV-1 surveillance systems
= HIV-1 sentinel surveillance
= Population-based surveys
= Ethical considerations for HIV-BED incidence EIA applications
= Unlinked anonymous testing

UNIT 5. Preparation: requirements for conducting the HIV-1 BED incidence EIA for HIV-1 incidence
surveillance

UNIT OVERVIEW:

This unit reviews the requirements for conducting the HIV-1 BED incidence EIA in surveillance activities
with respect to personnel, study populations, data, specimens, laboratory equipment, and costs. A
comprehensive checklist, list of supplies, and costs are included in Job Aids A-D of this unit.

LEARNING OBJECTIVES:
By the end of this unit, you should be able to:
= |dentify key laboratory and surveillance personnel needed to implement to HIV-1 BED incidence EIA
in surveillance activities
= |dentify which study sites and study populations are appropriate for BED HIV-1 incidence
surveillance activities
= |dentify the data requirements for conducting the HIV-1 BED incidence EIA in surveillance activities
= Determine if the quality of HIV testing and specimen handling are appropriate for HIV-1 BED
incidence EIA testing
= List laboratory supplies and equipment needed to conduct BED HIV-1 incidence surveillance
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= Calculate the number of kits to purchase for a given number of specimens to be tested

= Estimate costs to conduct the HIV-1 BED incidence EIA in your surveillance activities
UNIT CONTENTS:

= Preparing to apply the HIV-1 BED incidence EIA in your country

= Job Aid A: Checklist for initiating the HIV-1BED incidence EIA

= Job Aid B: Equipment and supply list

= Job Aid C: Formula to calculate number of kits for a given number of specimens

= Job Aid D: Estimated costs for conducting HIV-1 BED incidence EIA studies

UNIT 6. Using the laboratory BED data management workbook

UNIT OVERVIEW:

This unit describes in detail how to BED data are managed in the laboratory. The procedures outlined in
this unit are specific for the laboratory personnel that will be conducting the assay. We have included this
unit in the Surveillance training manual as a general overview for surveillance personnel to understand
how the data the source of BED data and how these data are generated in the laboratory.

LEARNING OBJECTIVES:

At the end of this unit, you will be able to:

Customize the workbook for your study

Generate a plate map for reference during the assay
Enter and analyze data from the initial test

Enter and analyze data from the confirmatory test
Confirm the validity of the test

Summarize the results of your study

UNIT CONTENTS:
= Getting ready to use the workbook
= Customizing the workbook for your study
= Entering/analyzing data for each initial test
= Entering/analyzing data from confirmatory test

UNIT 7. Data management of HIV-1 BED incidence EIA results

UNIT OVERVIEW:

This unit explains how manage HIV-1 BED Incidence data by appending antenatal clinic (ANC) data,
appending BED laboratory results, merging ANC and BED datasets, cleaning merged datasets, and
recode data variables. The goal of this unit is to describe the principles of appending, merging, and

cleaning data from the HIV-1 BED Incidence EIA in preparation for analysis.

Note the following exercises are conducted in STATA; however, other data management and statistical
software may be used to accomplish the same goals for data amangement (e.g. Epi Info 2000, SAS,
SPSS).

LEARNING OBJECTIVES:
By the end of this unit, you should be able to:
= Append ANC sentinel surveillance databases in EXCEL
= Append BED laboratory databases in EXCEL
= Merge BED and ANC databases in STATA
= Clean databases in STATA
= Recode data in STATA

UNIT CONTENTS:
= Appending ANC sentinel surveillance and BED laboratory databases
= Merging BED database to ANC databases
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= Data cleaning
= Recoding data

UNIT 8. Data analysis of HIV-1 BED incidence EIA results

UNIT OVERVIEW:

This unit explains how to use HIV-1 BED Incidence EIA results to calculate annual HIV-1 incidence rates
with 95% confidence intervals, how to use basic statistics for comparing HIV-1 incidence between
populations and over time, and sample size considerations.

LEARNING OBJECTIVES:
By the end of this unit, you should be able to:
= Conduct univariate analysis on your merged dataset
= Calculate annual HIV-1 incidence
= Calculate the 95% Confidence Interval
= Adjust BED-CEIA data for missing data
= Adjust HIV-1 incidence estimates for imperfect sensitivity and specificity of the assay
= Apply the appropriate statistical test for temporal trends in HIV-1 incidence
= Apply the appropriate statistical test for differences in HIV-1 incidence in different populations
= Consider issues in sample sizes for HIV-1 BED Incidence EIA testing

UNIT CONTENTS:

= Data analysis plan

= Univariate analysis of data

= Data management of univariate results

= Calculating HIV incidence

= Calculating HIV incidence from HIV-1 BED incidence EIA results

= Calculating 95% confidence interval for HIV incidence estimates
Adjusting incidence estimate for missing specimens

= Overestimation of HIV-1 incidence using the HIV-1 incidence EIA
Adjusting HIV-1 incidence estimates for imperfect sensitivity and specificity

= Estimating HIV-1 incidence from population based surveys

= Analyzing trends in HIV

= Analyzing risk factors for recent HIV seroconversion

= Sample size consideration

UNIT 9. Application and Use of the HIV-1 BED Incidence EIA data, Further Validations, and Post-
test Adjustments

UNIT OVERVIEW:
This unit discusses results from the application of the HIV-1 BED Incidence EIA in cross-sectional HIV
surveillance settings, limitations of HIV-1 incidence estimates, and further validations that are ongoing

LEARNING OBJECTIVES:
By the end of this unit, you should be able to:
= Understand how HIV-1 incidence data are used for public health action
= Compare HIV-1 BED Incidence EIA estimates with Spectrum incidence estimates
= Discuss issues related to overestimation of HIV-1 incidence using the BED-CEIA
= Discuss possible reasons for misclassification of long-term infection as recent infection on the BED-
CEIA
= Introduce post-test methods for adjusting BED-CEIA incidence estimates to correct for
misclassification
= Discuss issues related to extrapolation of HIV-1 BED Incidence EIA data to the general population
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UNIT CONTENTS:
= Use of HIV-1 incidence data
= Extrapolation of HIV-1 BED incidence estimates to the general population
= Using the ANC population for HIV incidence surveillance
= Comparison of HIV-1 BED incidence to Spectrum modeled incidence
= Future developments

UNIT 10. Potential errors, biases, and limitation of the HIV-1 BED incidence EIA and their solutions

UNIT OVERVIEW:
This unit identifies sources of potential bias in HIV-1 BED incidence EIA studies and the steps to minimize
these potential biases.

LEARNING OBJECTIVES:
By the end of this unit, you should be able to:
= |dentify sources of potential bias in the laboratory that affect HIV-1 BED incidence EIA results and
solutions to address them
= |[dentify sources of potential bias in epidemiological data used for HIV-1 BED incidence EIA
surveillance and solutions to address them

UNIT CONTENTS:
= Bias overview
= Biases resulting from errors in laboratory procedures
= Biases from errors in epidemiological study design, population-level effects, or project
implementation
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